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PDF Map Bucharest, Romania, printable vector street City Plan map, fully editable, Adobe PDF, full vector, scalable, editable, text format of street names, 22 Mb ZIP.

All streets, All buildings. Map for design, print, arts, projects, presentations.

The most accurate and detailed map of Bucharest.

Different font colors of the street names (black); object names by type (brown, red).

You can edit this file by Adobe Illustrator, Adobe Acrobat, Corel Draw.


SKU: 2016.19.06.BC.RO.CP.FU.PDF

Share this map for your friends!
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Map Categories



Europe maps, Romania vector maps: PDF and Adobe Illustrator

Extended Description of the Vector Map



Bucharest, Romania, printable vector street City Plan map, full editable, Adobe PDF, full vector,  scalable, editable, text format of street names, 22 Mb ZIP.

All streets, All buildings. Map for design, print, arts, projects, presentations.

The most accurate and detailed map of the city.

Different font colors of the street names (black); object names by type (brown, red).

You can edit this file in Adobe Illustrator, Adobe Acrobat, Corel Draw.

DXF, DWG, CDR and other formats – on request, same price, please, contact

 

 

Bucharest, Romania.

This vector map of Bucharest is used as a basis for design, editing, and further printing.

This is the most detailed, exact map of Bucharest for high-quality printing and polygraphy. You can always clarify the map development date by contacting us.

For your convenience, all objects on Bucharest vector map are divided into layers. And the editing is very easy – colors, lines, etc.

You can easily add any objects needed (e.g. shops, salons, sale points, gas station or attraction) on any layer of Bucharest vector map.

Bucharest (Romanian: București) is the capital and largest city of Romania, as well as its cultural, industrial, and financial centre. It is located in the southeast of the country, Coordinates: 44°25′57″N 26°06′14″E, on the banks of the Dâmbovița River, less than 60 km (37.3 mi) north of the Danube River and the Bulgarian border.



One of the advantages of Bucharest vector maps of our production is the relevance of cartographic data, we constantly update all our products.

This vector map of Bucharest is used by:

designers, layout designers, printers, advertisers and architects. Our product – vector maps – is designed for further editing and printing in large formats – from @Wall format (a few meters) to A-0 and A-1, A-2, A-3.

Bucharest map in vector format is used for design, urban planning, presentations and media visualizations.

Advertising and presentation map of Bucharest (usually the final designer marks the routes, and puts the client’s objects (shops, saloons, gas stations etc.)

The undoubted advantage is that people will NEVER throw out this advertising product – the map. In fact, as an advertising medium, a map is the most “long-playing” of the well-known polygraphic advertising media, with the longest lifespan, and the maximum number of interactions with the customer.

For travelers, maps are sold at the airports and gas stations around the world. Often the source is our vector maps.

Take a look, who purchases our vector maps of Bucharest in “Our Clients and Friends” page – these are large and small companies, from super-brands like Volvo and Starbucks, to small design studios and printing houses.

It’s very easy to work with vector maps of Bucharest, even for a not very experienced designer who can turn on and off the map layers, add new objects, change the colors of fill and lines according to customer requirements.



The undoubted advantage of Bucharest vector maps in printing is an excellent and detailed visualization, when customer can expand a large paper map and instantly define his location, find a landmark, an object or address on map, unlike using the popular electronic formats of Google and Yandex maps for example.

Printable vector maps of Bucharest are much more convenient and efficient than any electronic maps on your smartphone, because ALL DETAILS are displayed in the entire space of Bucharest map.

Useful tips on working with vector maps of cities and countries in Adobe Illustrator.

«V» – launches the Selection tool (cursor, black arrow), which makes active any vector line.

«А» – launches the Direct Selection tool (white cursor), allows you to select curve elements and drag them to the desired place.

«R» – activates the Rotate tool, which helps you rotating selected objects around the center point by 360 degrees.

«E» – gives you the opportunity to use the Eraser tool and erase unnecessary parts.

«X» – switches between Fill and Stroke in the Tools section. Try to get used to this hot key and

you will quickly understand that you can’t live and work without it.



Guides are not limited to vertical and horizontal in Adobe Illustrator. You can also create a diagonal guide for example. Moreover, you can turn any contours into guides. Select the outline and go to View > Guides > Make Guides (Create Guides), or simply press Cmd/Ctrl + 5. You can also turn the guides back into an editable object. Go to menu, View > Guides > Unlock Guides (Release Guides), select the guide you want to edit and select View > Guides > Release Guides (Reset Guides), or just press Cmd/Ctrl + Option / Alt + 5).

You will probably want to change the color scheme used on our Bucharest vector map.

To quickly and effectively play with colors.

Of course, you can do it manually, all objects in our Bucharest vector map are divided according to types and layers, and you can easily change the color gamma of vector objects in groups and layers.



But there is more effective way of working with the whole VECTOR MAP of Bucharest and all layers:

The overview dialog «Edit colors»/«Repaint Graphic Object» (this dialog box name can change depending on the context):

If you have selected a part or a layer of Bucharest vector map and open the dialog box by clicking the icon in the Control panel, on the Samples palette or the Color Catalog, or if you choose Edit > Edit Colors> Repaint Graphic Object, then the «Repaint Graphic Object» dialog box appears, and you get access to «Assign» and «Edit» tabs.

If a picture or a map fragment is not selected, and you open the dialog box by clicking the icon in the Control panel, on the Samples palette or in the Color Catalog, the «Edit Colors» dialog box appears and you can only access the «Edit» tab.

Regardless of the name at the top of the dialog box, the right-hand side always displays the color group of the current document, as well as two default color groups: Print Color and Grayscale. These color groups can be selected and used any time.

Create and edit color groups of Bucharest vector map, and also assign colors using the «Edit Colors»/ а «Repaint Graphic Object» dialog box.

A. Creating and editing of a color group on the «Edit» tab

B. Assigning colors on the «Assign» tab

C. Select a group of colors from the «Color groups» list

The option «Repaint a graphic object» in the lower part of the dialog box allows you to preview the colors on a selected layer of Vector map, or a group of elements, and specify whether its colors will be redefined when the dialog box is closed.

The main areas of the dialog box are:

«Edit»

The «Edit» tab is designed to create a new or edit the existing color groups.

The harmony rules Menu and the Color Wheel are used to conduct experiments with color harmonies. The color wheel shows how colors are related in color harmony, and the color bars allow you to view and manipulate an individual color values. In addition, you can adjust the brightness, add and remove colors, save color groups and view colors on the selected Vector Map of Bucharest or a separated layers.

«Assign»

The «Assign» tab is used to view and control on how the original colors are replaced with colors from the color group like your corporate colors in the Vector Map of Bucharest.

The assign color ability is provided only if the entire map, layer or fragment is selected in the document. You can specify which of new colors replace the current colors, whether the spot colors should be preserved and how colors are replaced (for example, you can replace colors completely or changing the color tone while maintaining the brightness). The «Assign» tab allows you to redefine colors in the Vector Map of Bucharest, or in separate layers and fragments using the current color group or reducing the number of colors in the current Vector Map.



Color groups

Is a list of all saved color groups for current document (the same groups appear in the «Samples» palette). You can edit and delete the existing color groups, as well as creating a new ones using the list of “Color Groups” in the dialog box. All changes appear in the «Samples» palette.

The highlighted color group shows, which color group is currently edited.

Any color group can be selected and edited, or used to redefine the colors in the selected vector map of Bucharest, its fragments or elements.

Saving a color group adds this group to the specified list.

Opening the «Edit Colors»/«Repaint Graphic Object» dialog box.

Open the «Edit Colors»/«Repaint Graphic Object» dialog box using one of the following methods:

«Edit»> «Edit Colors»> «Repaint Graphic object» or «Repaint With Style».

Use these commands if you need to edit the colors in the selected vector map of Bucharest.

«Repaint Graphic object» button on the «Control» panel.

Use this button if you need to adjust colors of Bucharest vector map using the а «Repaint graphic object» dialog box.

The specified button is available if the selected vector map or its fragment contains two or more colors.



Note. This color editing method is convenient for global color adjustment in a vector map, if global colors were not used when creating a Map of Bucharest.

The «Edit colors» button or «Edit or apply colors» on the «Color Catalog» palette

Click this button if you need to edit colors on the «Color Catalog» palette or edit and then apply them to the selected Vector Map of Bucharest or its fragment.

The «Edit color group» button or «Edit or apply color group» on the «Samples» palette.

Click this button if you need to edit the colors in the specific color group or edit and apply them to the selected Vector Map of Bucharest or a group of its elements, for example, the whole layer “Streets and lines”. You can also double-click the color group in the Samples panel to open the dialog box.

If the map file is too large and your computer freezes or even can’t open it quickly:

1. Try to reduce the color resolution of the video card (display) to 256 colors while working with a large map.

2. Using Windows Task Manager, select all the application you don’t need, while working with map, just turn them off.

3. Launch Adobe Illustrator. (DO NOT OPEN the vector map file)

4. Start the Windows Task Manager using administrator rights > Find the “Illustrator” process > set the «real time» priority,

5. Open the file. When you see the LEGACY FONT popup window – click “OK” (do not update). You can restore the TEXT later.

6. Can also be useful: When file is opened – Edit > Settings > Basic Settings > disable smoothing. /// It looks scary, but works quickly)))

We recommend saving the file in Adobe Illustrator 10 version. It’s much more stable when working with VERY BIG size files.



Bucharest was first mentioned in documents in 1459. It became the capital of Romania in 1862 and is the centre of Romanian media, culture, and art. Its architecture is a mix of historical (neo-classical), interbellum (Bauhaus and art deco), communist-era and modern. In the period between the two World Wars, the city’s elegant architecture and the sophistication of its elite earned Bucharest the nickname of “Little Paris” (Micul Paris). Although buildings and districts in the historic city centre were heavily damaged or destroyed by war, earthquakes, and above all Nicolae Ceaușescu’s program of systematization, many survived. In recent years, the city has been experiencing an economic and cultural boom. In 2016, the historical city centre was listed as “endangered” by the World Monuments Watch.

According to the 2011 census, 1,883,425 inhabitants live within the city limits, a decrease from the 2002 census. Adding the satellite towns around the urban area, the proposed metropolitan area of Bucharest would have a population of 2.27 million people. According to Eurostat, Bucharest has a functional urban area of 2,412,530 residents (as of 2015). Bucharest is the sixth-largest city in the European Union by population within city limits, after London, Berlin, Madrid, Rome, and Paris.

Economically, Bucharest is the most prosperous city in Romania and is one of the main industrial centres and transportation hubs of Eastern Europe. The city has big convention facilities, educational institutes, cultural venues, traditional “shopping arcades”, and recreational areas.

The city proper is administratively known as the “Municipality of Bucharest” (Municipiul București), and has the same administrative level as that of a national county, being further subdivided into six sectors, each governed by a local mayor.









 

Bucharest was first mentioned in documents in 1459. It became the capital of Romania in 1862 and is the centre of Romanian media, culture, and art. Its architecture is a mix of historical (neo-classical), interbellum (Bauhaus and art deco), communist-era and modern. In the period between the two World Wars, the city’s elegant architecture and the sophistication of its elite earned Bucharest the nickname of “Little Paris” (Micul Paris). Although buildings and districts in the historic city centre were heavily damaged or destroyed by war, earthquakes, and above all Nicolae Ceaușescu’s program of systematization, many survived. In recent years, the city has been experiencing an economic and cultural boom.

According to the 2011 census, 1,883,425 inhabitants live within the city limits, a decrease from the 2002 census.The urban area extends beyond the limits of Bucharest proper and has a population of about 1.9 million people. Adding the satellite towns around the urban area, the proposed metropolitan area of Bucharest would have a population of 2.27 million people. According to Eurostat, Bucharest has a larger urban zone of 2,183,091 residents. According to unofficial data, the population is more than 3 million. Bucharest is the sixth-largest city in the European Union by population within city limits, after London, Berlin, Madrid, Rome, and Paris.

Economically, Bucharest is the most prosperous city in Romania and is one of the main industrial centres and transportation hubs of Eastern Europe. The city has big convention facilities, educational institutes, cultural venues, traditional “shopping arcades”, and recreational areas.

The city proper is administratively known as the “Municipality of Bucharest” (Municipiul București), and has the same administrative level as that of a national county, being further subdivided into six sectors, each governed by a local mayor.

Small guide: How to work with the vector map?

You can: Mass select objects by type and color – for example, the objects type “building” (they are usually dark gray) – and remove them from the map, if you do not need them in your print or design project. You can also easily change the thickness of lines (streets), just bulk selection the road by the line color.

The streets are separated by type, for example, type “residential road” are usually white with a gray stroke. Highway usually orange with a brown or dark gray stroke.

It is easy to change the font of inscriptions, all or each individually. Also, just can be make and any other manipulation of objects on the vector map in Adobe illustrator format.

Important: All the proportions on the map are true, that is, the relative sizes of the objects are true, because Map is based on an accurate GPS projection, and It transated into the (usual for all) the Mercator projection.

You can easily change the color, stroke and fill of any object on the map, zoom without loss of quality Image Verification.

Select object



Bulk selection the same objects on the vector map



See the bulk selected objects on the vector map



Bulk delete buildungs from the vector map



Select residencial road (small street) on the vector map



Bulk selection the same lines (streets, roads) on the full map



Create fat lines of the streets on the vector maps (bulk action) 1



Create fat lines of the streets on the vector maps (bulk action) 2



Create fat lines of the streets on the vector maps (bulk action) 3



You can easily change the color, stroke and fill of any object on the map, zoom without loss of quality Image Verification. 

Bucharest  is the capital and largest city of Romania, as well as its cultural, industrial, and financial centre. It is located in the southeast of the country, at 44°25′57″N 26°06′14″ECoordinates: 44°25′57″N 26°06′14″E, on the banks of the Dâmbovița River, less than 60 km (37.3 mi) north of the Danube River and the Bulgarian border.

Bucharest was first mentioned in documents in 1459. It became the capital of Romania in 1862 and is the centre of Romanian media, culture, and art. Its architecture is a mix of historical (neo-classical), interbellum (Bauhaus and art deco), communist-era and modern. In the period between the two World Wars, the city’s elegant architecture and the sophistication of its elite earned Bucharest the nickname of “Little Paris” (Micul Paris). Although buildings and districts in the historic city centre were heavily damaged or destroyed by war, earthquakes, and above all Nicolae Ceaușescu’s program of systematization, many survived. In recent years, the city has been experiencing an economic and cultural boom. In 2016, the historical city centre was listed as “endangered” by the World Monuments Watch.

According to the 2011 census, 1,883,425 inhabitants live within the city limits, a decrease from the 2002 census. The urban area extends beyond the limits of Bucharest proper and has a population of about 1.9 million people. Adding the satellite towns around the urban area, the proposed metropolitan area of Bucharest would have a population of 2.27 million people. According to Eurostat, Bucharest has a larger urban zone of 2,183,091 residents. According to unofficial data, the population is more than 3 million. Bucharest is the sixth-largest city in the European Union by population within city limits, after London, Berlin, Madrid, Rome, and Paris.

Economically, Bucharest is the most prosperous city in Romania and is one of the main industrial centres and transportation hubs of Eastern Europe. The city has big convention facilities, educational institutes, cultural venues, traditional “shopping arcades”, and recreational areas.

The city proper is administratively known as the “Municipality of Bucharest” (Municipiul București), and has the same administrative level as that of a national county, being further subdivided into six sectors, each governed by a local mayor.

Geography of Bucharest

Bucharest is situated on the banks of the Dâmbovița River, which flows into the Argeș River, a tributary of the Danube. Several lakes – the most important of which are Lake Herăstrău, Lake Floreasca, Lake Tei, and Lake Colentina – stretch across the northern parts of the city, along the Colentina River, a tributary of the Dâmbovița. In addition, in the centre of the capital is a small artificial lake – Lake Cișmigiu – surrounded by the Cișmigiu Gardens. These gardens have a rich history, having been frequented by poets and writers. Opened in 1847 and based on the plans of German architect Carl F.W. Meyer, the gardens are the main recreational facility in the city centre.

Besides Cișmigiu, Bucharest parks on vector maps and gardens include Herăstrău Park and the Botanical Garden. Herăstrău Park is located in the northern part of the city, around Lake Herăstrău, and includes the site the Village Museum. The Botanical Garden, located in the Cotroceni neighborhood a bit west of the city centre, is the largest of its kind in Romania and contains over 10,000 species of plants (many of them exotic); it originated as the pleasure park of the royal family.

Black swans on Lake Cișmigiu in Cișmigiu Gardens

Lake Văcărești is located in the southern part of the city. Over 190 hectares, including 90 hectares of water, host 97 species of birds, half of them protected by law, and at least seven species of mammals. The lake is surrounded by buildings of flats and is an odd result of human intervention and nature taking its course. The area was a small village that Ceaușescu attempted to convert into a lake. After demolishing the houses and building the concrete basin, the plan was abandoned following the 1989 revolution. For nearly two decades, the area shifted from being an abandoned green space where children could play and sunbathe, to being contested by previous owners of the land there, to being closed for redevelopment into a sports centre. The redevelopment deal failed, and over the following years, the green space grew into a unique habitat. In May 2016, the lake was declared a national park, the Văcărești Nature Park.

Since 2015, Lake Văcărești, dubbed the “Delta of Bucharest”, is a protected area.

Bucharest is situated in the southeastern corner of the Romanian Plain, in an area once covered by the Vlăsiei Forest, which after it was cleared, gave way for a fertile flatland. As with many cities, Bucharest printable maps is traditionally considered to be built upon seven hills, similar to the seven hills of Rome. Bucharest’s seven hills are: Mihai Vodă, Dealul Mitropoliei, Radu Vodă, Cotroceni, Spirei, Văcărești, and Sf. Gheorghe Nou.

The city has an area of 226 km2 (87 sq mi). The altitude varies from 55.8 m (183.1 ft) at the Dâmbovița bridge in Cățelu, southeastern Bucharest and 91.5 m (300.2 ft) at the Militari church. The city has a roughly round shape, with the centre situated in the cross-way of the main north-south/east-west axes at University Square. The milestone for Romania‘s Kilometre Zero is placed just south of University Square in front of the New St. George Church (Sfântul Gheorghe Nou) at St. George Square (Piața Sfântul Gheorghe). Bucharest’s radius, from University Square to the city limits in all directions, varies from 10 to 12 km (6 to 7 mi).

Until recently, the regions surrounding Bucharest were largely rural, but after 1989, suburbs started to be built around Bucharest, in the surrounding Ilfov County. Further urban consolidation is expected to take place in the late 2010s, when the “Bucharest Metropolitan Area” on editable maps plan will become operational, incorporating additional communes and cities from the Ilfov and other neighbouring counties.

Source

București este capitala României și, în același timp, cel mai populat oraș și cel mai important centru industrial și comercial al țării. Populația de 1.883.425 de locuitori (2011) face ca Bucureștiul să fie al zecelea oraș ca populație din Uniunea Europeană. Conform unor estimări ale unor specialiști, Bucureștiul adună zilnic peste trei milioane de oameni, iar în următorii cinci ani, acest număr va depăși patru milioane. La acestea se adaugă faptul că localitățile din preajma orașului, care vor face parte din viitoarea Zonă Metropolitană, însumează o populație de aproximativ 430.000 de locuitori.

Prima mențiune a localității apare în 1459. În 1862 devine capitala Principatelor Unite. De atunci a suferit schimbări continue, devenind centrul scenei artistice, culturale și mass-media românești. Arhitectura elegantă și atmosfera sa urbană i-au adus în Belle Époque supranumele de „Micul Paris”. În prezent se situează pe același nivel administrativ cu județele României și este împărțit în șase sectoare.

Geografie of Bucharest

Articol principal: Geografia României.

Imagine din satelit a Bucureștiului în 2005

Așezare geografică și relieful

Bucureștiul se află în sud-estul României, între Ploiești la nord și Giurgiu la sud. Orașul se află în Câmpia Vlăsiei, care face parte din Câmpia Română. La est se află Bărăganul, în partea de vest Câmpia Găvanu Burdea, iar la sud este delimitat de Câmpia Burnazului.

Câmpia Bucureștiului, subunitate a Câmpiei Vlăsiei, se extinde în N-E și E până la Valea Pasărea, în S-E și S până la Câmpul Câlnăului și Lunca Argeș-Sabar, în S-V tot până la Lunca Argeș-Sabar, iar în N-V până la Câmpia Titu. S-a format prin retragerea treptată a lacului cuaternar, ca urmare a mișcării de înălțare a Carpaților și Subcarpaților și a intenselor aluvionări. În Pleistocenul superior aluviunile au fost acoperite cu loess și depozite loessoide, iar la începutul Holocenului depresiunea era complet exondată. În acest timp râurile își prelungesc cursurile și își intensifică eroziunea liniară în pătura groasă de loess, fragmentând astfel câmpia.

Câmpia Bucureștiului are altitudini cuprinse între 100–115 m, în partea nord-vestică, și 50–60 m, în cea sud-estică, în lunca Dâmboviței. Orașul propriu-zis se desfășoară între 58 m și 90 m altitudine. Peste 50% din suprafața sa se încadrează în intervalul hipsometric de 80–100 m, iar pantele nu depășesc valoarea de 2o. Fragmentarea este mai accentuată în jumătatea estică, unde se ajunge la 1-1,5 km/km2.

Relieful câmpiei este constituit dintr-o succesiune de câmpuri (interfluvii) și văi (cu terase și lunci) care se succed de la nord către sud:

Câmpul Băneasa (sau Otopeni), situat la nord de Valea Colentinei, are altitudini de 90–95 m și densitatea fragmentării mai mare în sectorul sudic, de 0,5–1 km/km2. La contactul cu versantul Văii Colentina, pantele pot depăși 5o.

Valea Colentinei este asimetrică (datorită versantului drept mai abrupt) și puternic meandrată. La intrarea în București are lățimea de 0,5 km, iar la ieșire, de 1,5 km. În lungul ei apar două terase joase (de 2–3 m și de 4–6 m) și martori desprinși din câmpuri sau din terase. Lunca este largă și bine dezvoltată pe ambele maluri, însă din cauza lucrărilor de regularizare a fost acoperită de apele lacurilor de acumulare. Se mai păstrează doar câteva popine sub forma unor insule: Plumbuita, Ostrov, Dobroești și Pantelimon.

Câmpul Colentinei (sau Giulești-Floreasca), cuprins între râul omonim și Dâmbovița, acoperă circa 36% din teritoriul Municipiului, având o înclinare ușoară pe direcța NV-SE (între 80 și 60 m altitudine). Densitatea fragmentării are valori cuprinse între 0 și 1 km/km2.

Râul Dâmbovița în București

Valea Dâmboviței este săpată în loess, având malul drept mai abrupt și înalt (aproximativ 10–15 m), iar cel stâng mai coborât (între 4–5 m în amonte și 7–8 m în aval). Terasele sunt dezvolte, predominant, pe partea stângă a râului și sunt în număr de patru. Până la amenajarea cursului, în luncă se găseau piscuri, popine, renii, grinduri, ostroave și maluri abrupte. În prezent se mai păstrează o serie de piscuri (Uranus-Mihai Vodă) și popine (Dealul Mitropoliei, Colina Radu Vodă, Movila Mare).

Câmpul Cotroceni-Berceni (sau Cotroceni-Văcărești) se desfășoară între Valea Dâmboviței, la nord, și de râul Sabar, la sud. Scade în altitudine de la vest (90 m) spre est (60 m), predominând treptele hipsometrice de 70–80 m și 80–90 m, iar densitatea fragmentării ajunge până la 0,5–1 km/km2.
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